
 

 

 

  

 
2020 Knowledge Based Preparations, Compilations and Reviews of Common Interest Realty Associations 

February 2020 

CCH® ProSystem fx® Knowledge Coach 

Welcome to 2020 Knowledge-Based Preparations, Compilations, and Reviews of Common Interest Realty 
Associations for Knowledge Coach 

This document provides important information about the 2020 release of Knowledge-Based Preparations, Compilations, and Reviews of 
Common Interest Realty Associations. Please review this information carefully. If you have any questions, additional information is available 
on CCH Support Online. 

New in this Release  

Knowledge-Based Preparations, Compilations and Reviews of Common Interest Realty Associations 
This title can be installed on CCH® ProSystem fx® Engagement v2018 by first installing the CCH ProSystem fx Engagement v2018.2.4 Update 
for Knowledge Coach. The latest update can be downloaded here. This update allows users to use the 2020 content without installing 
Engagement v2019 until your firm plans to update. 

The title is designed to help the practitioner efficiently and effectively perform financial statement audits of common interest realty 
associations (CIRAs)  in accordance with auditing standards generally accepted in the United States of America (U.S. GAAS). It can also assist 
with preparations, compilations, and reviews of common interest realty associations in accordance with Statements on Standards for 
Accounting and Review Services (SSARSs) issued by the American Institute of Public Accountants (AICPA). 

The Knowledge-Based Preparations, Compilations, and Reviews of Common Interest Realty Associations Entities methodology emphasizes 
using knowledge of the entity to perform preparation, compilation, and review engagements by facilitating the flow of information so that 
the understanding obtained in each process affects the decisions made in the next. Although the accountant will likely perform most steps 
in this methodology sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary 
engagement activities helps the accountant design and customize engagement procedures. Evidence gained from procedures performed is 
evaluated, and the appropriate accountant’s report, if any, is issued. This edition includes specific up-to-date guidance for conducting 
preparation, compilation, and review engagements in accordance with the SSARS. 

This document is published for the purpose of communicating the updates and enhancements included in the current version to users of 
the toolset. This document is not, and should not be used as, a program to update the documentation of an engagement started in a 
previous version of this product. 

If you are updating from a previous version of this title, refer to the Knowledge Coach User Guide, Chapter 12. The guide is found on the 
Engagement File Room Help menu.  

The 2019 documents include CCH® Accounting Research® material links to specific guidance, providing instant access to detailed analysis 
related to the steps and processes discussed in the workpapers.  

  

http://support.cch.com/productsupport/
https://support.cch.com/updates/Engagement/release2018/release2018.aspx
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2020 Edition of Knowledge-Based Preparations, Compilations and Reviews of Common Interest Realty Associations  
This edition features numerous enhancements, including:  

• Added new and modified procedure steps and practice points for the current accounting guidance noted below.  

• Added a new Microsoft® Word version of AID-301 to document materiality. Materiality does not flow, but using the Microsoft® 
Word version allows the user to keep their data on roll forward. 

• Updated KBR-201, KBC-201, and KBP-201 to include a new tailoring question on whether the user will document consideration in a 
memorandum format or considering each factor in detail. Also added a new section on “Independence and Ability to Provide 
Services.” 

• Added new KBCRs, CORs, and RPTs as follows: 

– KBCR-901A Tax Basis Financial Statement Disclosure Checklist 

– KBCR-901B Cash Basis Financial Statement Disclosure Checklist 

– COR-221F Engagmenet Letter: Preparation of Prospective Financial Information (Forecast) 

– COR-221G Engaagement Letter: Preapration of Prospective Financial Information (Projection) 

– AID-840 Payroll and Related Liabilities: Analytical Procedures 

– RPT-1116A Compilation Report: Other Matter - Required Supplementary Information That is Compiled - No Material 
Departures Identified 

– RPT-1122A Compilation Report: Departure from Applicable Financial Reporting Framework - Substantially All Disclosures and 
Stateement and Cash Flows Omitted 

Click here for the 2020 Preparations, Compilations and Reviews of Common Interest Realty Associations Title Overview for Knowledge 
Coach Users. 

In addition, forms and practice aids throughout have been updated to include new examples and tips. Where applicable, they also have 
been updated to take into account new literature, standards, and developments, as reflected in the following current accounting guidance: 

• Statement on Standards for Accounting and Review Services No. 24 (SSARS-24), Omnibus Statement on Standards for Accounting 
and Review Services - 2018) 

• AICPA Guide Preparation, Compilation and Review Engagements 

• The revised AICPA Code of Professional Conduct (Code), including ET Section 1.295, Nonattest Services 

• AICPA Statement on Quality Control Standards No. 8 (QC Section 10), A Firm's System of Quality Control (Redrafted) 

• AICPA Audit Risk Alert Developments in Preparation, Compilation, and Review Engagements - 2017/18 

• FASB Accounting Standards Codification™ as of December 31, 2019, through Accounting Standards Update No. 2019-12 

Important: 

• Save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

• If Microsoft® Word crashes when using Knowledge Coach, before closing the binder, use the Save Knowledge Coach Answers 
option in the binder view under the Tools Menu. This saves all data within tables. 

• You can view other Knowledge Coach Best Practices on our Web site. 

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2020%20CIRA%20PCR%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
https://support.cch.com/kb/solution/000034942/sw34947
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System Requirements 

This title requires the 2019 Financial Statement Base Title. The 2019 Financial Statement Base title must be installed with one of the 
following versions of Engagement and Knowledge Coach.  

• Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or later available here. To identify 
what version you are running, please go to the Help > About window in the application. 

• Engagement and Knowledge Coach v2018 or later. 

If you are upgrading from Engagement v7.1 or lower please contact Technical Support. 

A minimum of 4GB of RAM is required for optimal performance when opening and navigating through Knowledge Coach workpapers. 

License Requirements 

This title requires the Knowledge-Based Preparations, Compilations, and Reviews of Common Interest Realty Associations license.  
Any user that does not have a license for this title will not be able to use Knowledge Coach functionality in workpapers.  

For more information on updating your license, see How do I add or update CCH ProSystem fx Engagement Licenses? on our Web site.  

For more information on assigning licenses, see How do I assign Engagement Licenses? on our Web site. 

Download Instructions 

If you are planning to use this title on Engagement and Knowledge Coach v2018, apply CCH ProSystem fx Engagement v2018.2.4 Update to 
all machines, including Admin servers and terminal servers, before installing the title. Review the Update's release notes for more 
information on deployment. 

To download this title: 

1. Navigate to the Knowledge Coach Updates section of the Engagement Support Website.  

2. Select the Knowledge Coach Series. The series are arranged by title type, then industry. 

3. Click Download File next to the title you want to download. 

Note: On some occasions, the Knowledge Coach Content Package file (.KCP) downloads with the extension changed to ZIP. If this occurs, 
please change the extension of the downloaded file to KCP using all capital letters. 

You must install the 2019 Financial Statement Base title before installing the 2020 Knowledge Based Preparations, Compilations, and 
Reviews of Common Interest Realty Associations.  

The Financial Statement Base title is also available on the Knowledge Coach Update Web site.    

The KCP download is a proprietary file that must be installed from within Engagement. Save this KCP file to a location on your local drive, 
and follow the Installation Instructions below. 

Installation Instructions 

See How do I add a new CCH® ProSystem fx® Knowledge Coach title to CCH® ProSystem fx® Engagement? for instructions on installing a 
new CCH ProSystem fx Knowledge Coach title. 

https://support.cch.com/updates/Engagement/release2018/release2018.aspx
https://support.cch.com/contact
https://support.cch.com/kb/solution.aspx/sw3937
https://support.cch.com/kb/solution.aspx/sw3943
https://d2iceilwdglxpz.cloudfront.net/release_notes/CCH%20ProSystem%20fx%20Engagement%202018.2.4%20Release%20Notes.pdf
http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach
https://support.cch.com/kb/solution/000033707/sw30271
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Using Your Knowledge Coach Content with CCH® Accounting Research Manager® 

CCH Accounting Research Manager (ARM) is the most comprehensive, up-to-date and objective online database of financial reporting 
literature. It includes all authoritative and proposed accounting, and SEC literature, plus independent, expert-written interpretive guidance. 

Available on ARM, the Knowledge-Based Preparations, Compilations, and Reviews of Common Interest Realty Associations Guide helps you 
comply with the most recent professional standards and guidance for the conduct of preparations, compilations, and reviews and to 
integrate the use of practice aids, tools, and other resources with its guidance. This publication supplements and complements the 
Knowledge-Based documents that are available in Knowledge Coach. 

If you subscribe to an ARM library that includes Preparations, Compilations, and Reviews of Common Interest Realty Associations content, 
you can link directly to source material from Resources in Knowledge Coach documents. These links have been updated to refer to the 
accounting standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Preparations, 
Compilations, and Reviews of Common Interest Realty Associations Guide on ARM, you can take advantage of references to the guide 
material from the Knowledge Coach documents.  

With ARM, you maximize the efficiency of your research time, while enhancing your results. Learn more about our content, our experts, 
and how you can request your free trial by visiting the ARM Web site. You can also access the ARM Web site by selecting Engagement > 
Binder Window > Shortcuts Bar > Guidance tab.  

Using Your Knowledge Coach Content 

To use your Knowledge Coach Workpaper Templates, do the following: 

1. Open a binder in Engagement. 

2. Select the workpaper tab into which you would like to insert the workpaper. 

3. Select New Knowledge Coach Workpaper from the toolbar or File menu.  

4. Select the new Knowledge Coach title with the content you would like to use. You can only select titles you have installed. The 
information displayed changes to reflect the workpaper organization available for the selected title.  

5. Select the Knowledge Coach workpapers to insert into your binder and click OK.  

6. In the Selected Workpaper Properties window, add a workpaper index in the Index field and make any Name modifications that are 
needed. You can also modify the tab location or the roll forward settings for each workpaper. 

7. Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.  

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.  

Additional Information on Knowledge Coach and the Knowledge-Based Audit Methodology 

The Knowledge-Based Audit (KBA) Methodology allows the results of one set of procedures to become the input for the next. The key 
components of the KBA methodology include: 

• An overview that guides accountants through the methodology 

• Knowledge-Based Preparation, Compilation, and Review of Common Interest Realty Associations documents, integral to the risk 
assessment and overall accounting processes, which contain steps and procedures required by SSARS 

• Customizable programs that take accountants through related steps and procedures 

http://www.accountingresearchmanager.com/
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• Practice aids to help accountants complete steps or processes outlined in the Knowledge-Based Preparation, Compilation, and 
Review of Common Interest Realty Associations documents and programs 

• Accountant’s reports that provide a variety of sample accountant’s opinions on financial statements 

• Correspondence documents that provide sample letters to be used to comply with SSARS requirements and in many other 
common situations 

The practice aids and tools in the 2020 Knowledge-Based Preparations, Compilations, and Reviews of Common Interest Realty Associations 
are designed around the AICPA’s Accounting and Review Services Committee (ARSC) SSARS standards to assist accountants by: 

• Facilitating compliance with SSARS 

• Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids 

• Enhancing engagement documentation 

CCH® ProSystem fx® Knowledge Coach 
Knowledge Coach functionality allows accountants to use the Knowledge-Based methodology more efficiently by eliminating the need for 
duplicate entry of the same information, tailoring documentation to each particular engagement, and documenting the link between risks 
identified and procedures performed. PRP-100 Engagement-Level Tailoring Questions, CMP-100 Engagement-Level Tailoring Questions or 
REV-100 Engagement-Level Tailoring Questions are documents in Knowledge Coach that presents engagement-level questions designed to 
aid in tailoring the engagement documentation to fit each client. Completing the questions helps the accountant avoid duplication and 
unnecessary workpapers. 

Note: Before you begin your engagement, please review the guidance in PRP-101 Overall Preparation Program, CMP-101 Overall 
Compilation Program, or REV-101 Overall Review Program. This workpaper is intended to be your road map through a Knowledge-Based 
methodology. You should start your engagement with PRP-100 Tailoring Question Workpaper, CMP-100 Tailoring Question Workpaper or 
REV-100 Tailoring Question Workpaper and PRP-101 Overall Preparation Program, CMP-101 Overall Compilation Program or REV-101 
Overall Review. 

• Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502 
Summary of Risk Assessments. This allows you to continuously assess risks during the engagement. Several workpapers prompt you 
to consider the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented risks flow 
to the Risk Summary. To ensure risks show in findings tables, select the workpaper identified in field of the Risk pane. 

• Information Flow helps reduce the time spent duplicating information across forms. In addition, the flow of consistent information 
ensures that information and updates to information are not missed between workpapers. Drill-down functionality helps the user 
navigate quickly to the source of the information, aiding in the review of the audit file. 

• Diagnostics help track unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant 
assertions, missing workpaper, and more.  

• Links to Accounting Research Manager (ARM), if you subscribe to an ARM library that includes audit content, link directly to source 
material from Resources within Knowledge Coach workpapers. These links have been updated to reference the accounting 
standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA. Also, if you subscribe 
to the Knowledge-Based Audits of Common Interest Realty Associations Guide on ARM, you can take advantage of links to the audit 
guide material from within the Knowledge Coach documents. 

• Interpretive Guidance is integrated in each Knowledge Coach template through the Tips view of each new task pane. Informational 
features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and 
efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting Research Manager 
and industry audit guides by simply clicking on the reference.  
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Download Description 
2020 Knowledge-Based Preparations, Compilations and Reviews of Common Interest Realty 
Associations 

Version 

Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or 
later 
OR  
Engagement and Knowledge Coach v2019 or later 

2019 Financial Statement Base 

Release Date February 2020 

File size 18MB 

Approx. Download Time 42 minutes at 56 kbps 

License Full Version 

Platforms Microsoft® Windows® 8.1, 10 

Office Microsoft® Office 2013 or higher required 
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